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BAB 1 
PENGENALAN  

PROGRAM WINGEOM 
 
 

Tujuan Pembelajaran 

Dalam modul ini mahasiswa akan mempelajari pengenalan 
program wingeom melalui kegiatan belajar 1. Setelah membaca dan 
mengikuti perkuliahan mahasiswa diharapkan dapat: 

1. Mengenal Area dan Menjalankan Program Wingeom 
2. Mengetahui Fasilitas Program Wingeom 2D 

 

KEGIATAN BELAJAR 1 

 Mengenal Area dan Menjalankan Program Wingeom 
Wingeom software merupakan suatu perangkat lunak 

komputer matematika dinamik (dynamic mathematics software) 
untuk topik geometri. Program ini dapat digunakan untuk membantu 
pembelajaran geometri dan pemecahan masalah geometri. Salah satu 
keunggulan dari software ini adalah dapat diperoleh dan digunakan 
secara gratis (totally freeware).  

Software ini dikembangkan oleh Dr. Richard Parris, seorang 
tenaga pengajar di Philips Exeter Academy di New Hampshire. 
Wingeom merupakan suatu paket software yang memungkinkan 
pengguna menggambar geometri 2D maupun 3D menggunakan 
komputer. Akan tetapi dalam pembahasan kali ini hanya dibahas 
mengenai geometri 2D. Berikut tampilan awal wingeom software: 

 

Gambar 1-1 
Tampilan awal Wingeom 
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Pada tampilan awal terdapat dua menu yaitu Windows dan 
Help. Klik menu Window maka akan muncul 2-dim (membuka 
program wingeom untuk geometri dimensi dua), 3-dim (membuka 
program wingeom untuk geometri dimensi tiga), Hyperbolik 
(membuka program wingeom untuk geometri hyperbolik), Sperical 
(membuka program wingeom untuk geometri bola), Voronai 
(membuka program wingeom untuk diagram voronai), Guess 
(membuka program wingeom untuk memprediksikan macam-
macam transformasi yang mungkin dengan menggunakan dua buah 
segitiga), Tesseletion (membuka program wingeom untuk 
menampilkan macam-macam pengubinan dari bangun-bangun 
geometri dimensi dua), RGB demo (membuka program wingeom 
untuk simulasi pencampuran warna RGB). Open last (membuka file 
yang terakhir dibuka saat program dijalankan kembali), Use defaults 
(mengembalikan tampilan kesetingan awal), Exit (keluar dari 
program wingeom).  

 

 Program Wingeom 2D 
Tampilan awal 2-dim (membuka program wingeom untuk 

geometri dimensi dua), menyediakan beberapa menu bar yaitu:  

 

Gambar 1-2 
Tampilan Wingeom-2 dim 

 

Untuk memperbesar tampilan layar klik icon    (maximize), 
untuk memperkecil tampilan layar klik icon      (minimize). Berikut 
penjelasan keterangan submenudan fungsinya untuk setiap icon 
pada tampilan menu bar. 
 
 

Menu Bar 

Layar 
gambar 
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1. File 
Menu file memuat beberapa sub menu yang terkait dengan 

pengolahan file seperti yang dirangkum dalam Tabel di bawah ini. 
Secara umum setiap menu dalam program Wingeom diberikan suatu 
keterangan dalam sub menu Help (untuk masing-masing menu).  

 

Submenu Fungsi 
New Membuat file wg2 baru.  
Open Membuka file .wg2 yang tersimpan.  
Save Menyimpan file wg2 yang sedang aktif.  
Save as Menyimpan file wg2 yang aktif dengan nama 

baru.  
Print Mencetak tampilan >gambar file wg2 yang 

sedang aktif.  
Format Memformat tampilan yang akan di-print.  
Select printer  Mengatur tampilan kertas yang akan di-

print dan option-option pada page setup. 
Copy to clipboard Mengkopi tampilan file wg2 yang sedang 

aktif dan menyimpannya dalam clipboard. 
With back color Mengkopi tampilan file wg2 yang sedang 

aktif wg2 dengan warna latar belakangnya 
High resolution Mengatur gambar dalam resolusi tinggi  
Save as metafile Menyimpan gambar sebagai file EMF 
Image size  Menampilkan ukuran gambar yang kita 

inginkan 
Bitmap to clipboard Mengkopi tampilan file wg2 yang sedang 

aktif sebagai file dalam format bitmap 
Password Memberikan password pada file yang kita 

buat (simpan), untuk memproteksi 
beberapa pilihan. 

Author Menampilkan keterangan nama pembuat file 
(akan muncul jika file diberi password) 

Help Menampilkan informasi tentang keterangan 
menu file. 

 

2. Point 
Menu Point memuat sub menu yang terkait dengan 

penyusunan dan pengoalahan titik, misalnya bagaimana Melukis 
titik, meletakan titik pada posisi yang kita inginkan dan lain-lain. 
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Keterangan tentang menu Point dicantumkan dalam dapat dilihat 
dalam Tabel di bawah ini.  

 
Submenu Fungsi 

On Segment Melukis titik pada suatu ruas garis, dengan perbandingan 
tertentu 

on Circle Melukis titik pada suatu ruas lingkaran, dengan sudut 
tertentu 

in Triangle Melukis titik pada sebuah segitiga, dengan perbandingan 
tertentu terhadap sisi-sisinya 

on Polygon Melukis titik pada sebuah segibanyak, dengan 
menggunakan 
mouse atau dengan menggunaakan koordinat 

Coordinates Melukis bidang koordinat 

Intersection Melukis titik potong garis dengan garis, lingkaran dengan 
lingkaran, garis dengan lingkaran, submenu berikut: 

Line-line 
Circ-circ 
o Mixed 

Melukis titik potong garis dengan garis 
Melukis titik potong lingkaran dengan lingkaran 
o Melukis titik potong garis dengan lingkaran 

Random Point Melukis titik sembarang pada ruas garis atau lingkaran, 
submenu berikut: 

o on-Segment 
o on-circ 

o Melukis titik sembarang pada ruas garis 
o Melukis titik sembarang pada lingkaran 

Special Melukis titik-titik khusus, seperti titik pusat lingkaran 
dalam, 
lingkaran luar, titik fermat, dsb, submenu berikut: 

o Circumcenter 
 
o Incenter 

 
o Orthocenter 

 
o Fermat point 

 
 
o Brocard point 

 
 
o Polygon 

centroid 
o Vertex centroid 

o Melukis titik pusat lingkaran luar untuk segitiga 
(tiga titik) yang diberikan 

o Melukis titik pusat lingkaran dalam untuk segitiga 
(tiga titik) yang diberikan 

o Melukis titik potong garis tinggi untuk segitiga (tiga 
titik) yang diberikan 

o Melukis titik Fermat untuk segitiga (tiga titik) yang 
diberikan, yaitu titik F (untuk segitiga ABC) yang 
meminimalkan AF +BF + CF. 

o Melukis titik Brocard untuk segitiga (tiga titik) yang 
diberikan, yaitu titik P (untuk segitiga ABC) yang 
membuat sudut <PAB, <PBC dan <PCA sama besar 

o Melukis titik berat segibanyak dengan merata-rata 
koordinat titik sudut segibanyak 

o Melukis titik berat segibanyak dengan mencari pusat 
gravitasi segibanyak, dengan mengasumsikan 
poligon konveks. 

Paste Menempelkan teks yang sudah disimpan dalam clipboard 

Help Menampilkan informasi tentang menu Point. 
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3. Line 
Menu Line memuat beberapa sub menu tentang penyusunan 

dan pengolahan garis misalnya menggambar ruas garis, meletakkan 
ruas garis pada posisi yang kita inginkan dan lain-lain. Keterangan 
tentang menu Linear dapat dilihat dalam Tabel di bawah ini.  

 

Submenu Fungsi 
Segments Melukis ruas garis untuk 2 titik yang diberikan 

Lines Melukis garis untuk 2 titik yang diberikan 

Rays Melukis sinar garis untuk 2 titik yang diberikan 

Parallels Melukis garis yang sejajar pada ruas atau garis dan 
melalui titik 
tertentu. 

Angle Melukis sudut , submenu berikut: 

 New angles 
 Bisect old 

 Melukis sudut baru dengan sinar asal dan 
besar sudut tertentu 

 Melukis garis bagi sudut untuk sudut yang 
diberikan 

Perpendiculars Melukis garis yang tegak lurus, submenu berikut: 

 Altitudes 
 

 Perp 
bisectors 

 
 General 

 Melukis garis yang tegak lurus sebuah garis 
dan dari titik tertentu. 

 Melukis garis yang tegak lurus sebuah garis 
dan melalui titik tengahruas garis tersebut. 

 Melukis garis yang tegak lurus sebuah garis 
dan melalui titik tertentu. 

Tangents Melukis garis singgung titik-lingkaran atau 
lingkaran-lingkaran, 
submenu berikut: 

 Point-circ 
 Circ-circ 
 Point-conic 

 Melukis garis singgung titik dan lingkaran 
 Melukis garis singgung lingkaran dan lingkaran 
 Melukis garis singgung titik dan conic (irisan 

kerucut) 

Equation Melukis garis dengan menggunakan persamaan 
(axis harus aktif) 

Vector sum Melukis jumlahan vector untuk 2 vektor dan titik 
asal yang diberikan 

Extensions Melukis perpanjangan ruas garis yang telah 
diberikan 

Help Menampilkan informasi tentang menu Line. 
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4. Circle  
Menu Circle memuat beberapa sub menu tentang lingkaran. 

Menu Circle dapat dijalankan jika ada lingkaran yang telah dibuat. 
Menu Circle dapat digunakan untuk menambahkan bidang lengkung 
pada suatu bangun ruang. Keterangan tentang menu Curved dapat 
dilihat dalam Tabel di bawah ini. 

 
Submenu Fungsi 

Circumcircle Melukis lingkaran luar untuk tiga titik yang diberikan 

Incircle Melukis lingkaran dalam untuk tiga titik yang 
diberikan 

Radius-
center 

Melukis lingkaran dengan titik pusat dan jari-jari atau 
titik yang 
diberikan, atau melukis busur dengan titik awal dan 
besar sudut atau titik akhir tertentu 

Poincare Melukis busur Poincare pada suatu lingkaran 

Excircle Melukis lingkaran diluar suatu segitiga yang 
menyentuh salah satu sisi dan menyentuh 
perpanjangan dua sisi yang lainnya. 

Tangent 
circle 

Melukis tiga lingkaran yang saling bersinggungan 
dengan 3 titik yang diberikan sebagai titik pusat 

Soddy circle Melukis lingkaran Soddy 

Equation Melukis lingkaran dengan menggunakan persamaan 
(axis harus aktif) 

Help Menampilkan informasi tentang menu Circle. 

 
5. Units 

Menu Unit memuat beberapa sub menu untuk menampilkan 
bangun bidang datar tertentu. Misalnya menggambar segitiga, 
segibanyak dengan ukuran tertentu dan lain-lain. Keterangan tentang 
menu Unit dapat dilihat dalam Tabel di bawah ini. 

 
Submenu Fungsi 

Triangle Melukis segitiga untuk beberapa besaran yang 
diberikan, submenu berikut: 

 ASA 
 SAS 
 SSS 
 HL 

 Melukis segitiga dengan memberikan 
besar Sudut, Sisi, Sudut 

 Melukis segitiga dengan memberikan 
besar Sisi, Sudut, Sisi 

 Melukis segitiga dengan memberikan 
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Submenu Fungsi 
besar Sisi, Sisi, Sisi 

 Melukis segitiga dengan memberikan 
besar Sisi miring dan Sisi lengan 

Polygon Melukis segibanyak beraturan, jajaran 
genjang , layang-layang, bintang untuk 
beberapa besaran yang diberikan, submenu 
berikut: 

 Regular 
 

 Parallelogram 
 
 Isosceles 

trapezoid 
 Kite 

 
 Star 

 
 Attach 

 
 Regular 

 
 Figure 

 Melukis segibanyak beraturan dengan 
memberikan banyaknya sisi dan panjang 
sisi 

 Melukis jajaran genjang dengan 
memberikan besar Sisi, Sudut, Sisi. 

 Melukis trapesium sama kaki dengan 
memberikan besar Sisi, Sudut, Sisi. 

 Melukis layang-layang dengan 
memberikan besar Sisi, Sudut, Sisi. 

 Melukis bangun bintang dengan 
memberikan banyak titik, keterhubungan 
dan panjang sisi 

 Menempelkan sebanyak pada ruas garis 
yang diberikan, aturan pelabelan 
mengikuti arah jarum jam 
 Menempelkan segibanyak beraturan 

pada ruas garis yang diberikan 
 Menempelkan segibanyak pada ruas 

garis yang diberikan 
Random Melukis berbagai bangun datar sembarang, 

submenu berikut 
 Triangle 
 Circle 
 Isosceles 

triangle 
 Right triangle 
 Rectangle 
 Parallelogram 
 Rhombus 
 Kite 
 Inscribed 

polygon 
 

 Melukis segitiga sembarang 
 Melukis lingkaran sembarang 
 Melukis segitiga samakaki sembarang 
 Melukis segitiga siku-siku sembarang 
 Melukis persegi panjang sembarang 
 Melukis jajaran genjang sembarang 
 Melukis belah ketupat sembarang 
 Melukis laying-layang sembarang 
 Melukis segi banyak sembarang dengan 

memberikan banyak titik sudut, yang 
titik sudutnya menyentuh lingkaran yang 
melingkupinya 
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Submenu Fungsi 
 
 Convex 

polygon 
 Trapezoid 
 Isosceles 

trapezoid 
 Coaster 

 Melukis segi banyak konveks sembarang 
 Melukis trapesium sembarang 
 Melukis trapezium sama kaki sembarang 
 Menampilkan berbagai daerah bangun 

segibanyak 

Segment Melukis ruas garis dengan panjang tertentu 
Grid  Melukis kisi dengan besaran-besaran tertentu 

yang diberikan 
3-Point conics Melukis irisan kerucut dengan diketahui 3 

titik tertentu 
5-Point conics Melukis irisan kerucut yang melaui 5 titik 
Array of circles Melukis barisan lingkaran 
 Rectangular 
 Triangle 
 Chain 

 Melukis barisan lingkaran dalam bentuk 
baris dan kolom 

 Melukis barisan lingkaran dalam bentuk 
segitiga 

 Melukis barisan lingkaran dalam bentuk 
rantai 

Duplicate Menduplikasi gambar dengan perbesaran 
tertentu 

Help Menampilkan informasi tentang menu Unit. 
 

6. Transf  
Menu Transf memuat beberapa sub menu perintah 

transformasi yang dapat kita lakukan pada bangun datar. Misalnya 
merotasikan suatu segitiga dengan pusat rotasi tertentu dan besar 
sudut tertentu, mentranslasikan ruas garis, dan lain-lain. Keterangan 
tentang menu Transf dan fungsi submenu di dalamnya dapat dilihat 
dalam Tabel di bawah ini. 

 
Submenu Fungsi 

Translate Melukis hasil translasi suatu bangun dengan 
perbesaran dan arah tertentu 

Rotate Melukis hasil rotasi suatu bangun dengan pusat, 
sudut dan perbesaran tertentu 

Dilatate Melukis hasil dilatasi suatu bangun dengan pusat, 
sudut dan perbesaran tertentu 

Glide-reflect Melukis hasil pencerminan-geser suatu bangun 
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dengan pergeseran dan arah tertentu 
Last repeat Mengulang transformasi terakhir yang dilakukan 
Mirror Melukis hasil pencerminan suatu bangun dengan 

sumbu cermin suatu ruas garis tertentu 
Invert Melukis hasil pencerminan suatu bangun dengan 

sumbu cermin suatu lingkaran tertentu 
Save labels Selalu menuliskan label hasil transformasi, meskipun 

berimpit 
Atribute 
copy 

Mempertahankan atribut yang sudah dibuat dalam 
hasil transformasinya 

Fill copy Mempertahankan pewarnaan daerah bangun datar 
dalam hasil transformasinya 

Help Menampilkan informasi tentang menu transf. 
 

7. Edit  
Menu Edit memuat beberapa sub menu tentang peng-edit-an, 

penambahan atribut dan pengaturan tertentu. Misalnya 
membatalkan pekerjaan yang baru saja dilakukan, menghapus titik 
yang telah dibuat dan lain-lain. Keterangan tentang menu Edit dapat 
dilihat dalam Tabel di bawah ini :  

 
Submenu Fungsi 

Undo Membatalkan pekerjaan yang baru saja 
dilakukan. 

Redo Menampilkan kembali pekerjaan yang baru 
saja dibatalkan. 

Labels Memuat beberapa sub menu peng-editan 
pada label bangun datar yang sudah dibuat, 
submenu berikut: 

Letters on/of 
Home 

Offset 
Font 

Opaque 
Color 
Move color 

Swap 
Dot mode 
Bullet size 

Individual 

Menampilkan atau tidak menampilkan 
label titik 
Menampilkan label titik pada posisi 
semula 
Menampilkan label agar tidak berimpit 
dengan titik 
Mengatur jenis dan ukuran font label 
Menampilkan label di atas titik 
Mengatur warna label 

Mengatur warna label titik saat titik 
digeser 
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Submenu Fungsi 
Menukar label dua buah titik 
Mengatur tampilan noktah suatu titik 
Mengtur ukuran noktah suatu titik 

Mengatur pilihan tampilan noktah 
untuk titik-titik tertentu 

Highlights Memuat beberapa sub menu peng-editan 
pada bangun datar yang sudah dibuat, 
submenu berikut: 

Line attributes 
Circle attributes 

Fill region 

Mengatur ketebalan, warna dan gaya garis 
Mengatur ketebalan, warna dan gaya 
lingkaran 
Mewarnai atau mengarsir suatu poligon 
atau lingkaran 

Marking 
 
_ tick 
_ arrow 
_ angle arch 
_ perp bracket 
_ ray/vector 
_ directed angle 

Memberikan tanda-tanda tertentu pada 
bangun datar, dengan type berikut: 
_ garis pendek di tengah garis 
_ mata panah di tengah garis 
_ tanda sudut 
_ tanda sudut 
_ tanda panah pada ujung sinar atau vektor 
_ tanda sudut berara 

Tick lengt 
Arrowlength 

Arc radius 
Braket length 

Mengatur ukuran garis pendek di 
tengah garis 
Mengatur ukuran mata panah di tengah 
garis 
Mengatur ukuran tanda sudut 
Mengatur ukuran tanda sudut 

Delete Menghapus obyek yang sudah dibuat 
seperti titik, garis dan lingkaran, submenu 
berikut 

Point 
Line 

Circle 
All line 
Text 

Menghapus titik yang dipilih 
Menghapus garis yang dipilih 

Menghapus lingkaran yang dipilih 
Menghapus semua garis 
Menghapus semua text 

Pen attributes Mengatur ketebalan, gaya dan warna 
gambar 

Coordinates Melukis titik dengan memasukkan 
koordinatnya 
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Submenu Fungsi 
Header ... Menuliskan text yang akan muncul 

dibagian atas history. 
Decimal ... Mengatur tempat desimal pada menu 

measurement. 
Function ... Mendefinisikan suatu fungsi 
Macro 
Define 
Open macro 
window 
Apply 

Undo 
Replay 

Mendefinisikan suatu makro 
Mendefinisikan macro 
Membuka jendela macro 
 
Menggunakan macro 

Membatalkan macro 
Menjalankan kembali macro 

Randomize Menampilakan gambar baru secara acak. 
Help Menampilkan informasi tentang menu edit. 
 

8. Meas  
Menu measatau measurement digunakan untuk mencantumkan 

ukuran-ukuran tertentu yang dapat ditampilkan pada jendela wg2. 
Misalnya ukuran panjang suaturuas garis, jarak antara dua titik, luas 
suatu bidang dan lain-lain. Perintahdiketikan pada jendela meas yang 
tampil.Keterangan tentang perintah pada menu Meas dapat dilihat 
dalam Tabel di bawah ini : 

 
Perintah 

(misalkan) 
Ukuran yang ditampilkan 

AB panjang ruas garis AB 
<ABC besar sudut ABC 
ABC luas daerah ABC 
ABCDE luas daerah ABCDE 
AB+BC panjang ruas garis AB ditambah panjang ruas 

garis BC 
[per](ABCD) keliling segibanyak ABCD 
AB/AC rasio panjang AB dan AC 
AB*AC panjang AB kali panjang AC 
[sq](AB) akar dari panjang AB 
A koordinat titik A 
[x](A) absis titi A 
[sin](<ABC) nilai sinus sudut ABC 
[arc](ABC) panjang busur dengan jari-jari BA dan sudut 
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Perintah 
(misalkan) 

Ukuran yang ditampilkan 

pusat ABC 
[pie](AB) luas daerah lingkaran dengan jar-jari AB 
[pie](ABC) luas daerah bagian lingkaran dengan jari-jari 

BA dan sudutpusat ABC 
[slope] (A,B) gradien garis AB 
[eqn](A, B) persamaan garis dengan gradien dan titik 

potong sumbu-yuntuk ruas garis AB. 
[rad](<ABC) ukuran radian untuk sudut ABC 
[pi] menampilkan nilai pi 
[phi] menampilkan nilai golden rasio 
[per](A->K) keliling segi banyak ABCDEFGK 

 
Dengan cara yang sama dapat juga berlaku untuk fungsi-fungsi: 

cos, tan, sec, csc, cot, arcsin, arcos, arctan, sq (square), sqr (square 
root), int, frac, sgn,abs, exp, ln, log. Untuk mode-radian digunakan 
perintah: sinr, cosr, tanr, secr, cscr, cotr, arcsinr, arccosr, arctanr.  

 
9. Btns 

Menu Btns memuat beberapa sub menu tentang buttons, yaitu 
menu untuk mengatur fungsi “klik” kanan dan kiri pada mouse. 
Keterangan tentang menu Btns dapat dilihat dalam Tabel di bawah 
ini : 

 
Submenu Fungsi 

Segments Mengatur fungsi mouse untuk melukis ruas 
garis 

Rays Mengatur fungsi mouse untuk melukis 
sinar garis 

Lines Mengatur fungsi mouse untuk melukis 
garis 

Circles Mengatur fungsi mouse untuk melukis 
lingkaran 
tie text Mengikat text pada 

Drag vertices Mengatur fungsi mouse untuk 
menggerakkan titik 

Text Mengatur fungsi mouse untuk menuliskan 
text 

opaque background Text berada di depan bidang gambar (tidak 
tembus) 
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Submenu Fungsi 
hyphen_ ASCII Mengatur tanda hubung dengan karakter 

ASCI tertentu 
text angle Sudut kemiringan text (derajat) 
font Membuka jendela font, untuk memilih font 
Paste from clipboard Mengatur fungsi mouse untuk 

menempelkan obyek yang tersimpan dalam 
clipboard 

XY coords Mengatur fungsi mouse untuk 
menempatkan titik yang diklik di tengah-
tengah bidang koordinat 

Rotation Mengatur fungsi mouse untuk 
menempatkan titik sebagai rotasi titik-titik 
di sekitarnya 

Toolbar Memunculkan jendela toolbar 
Lattice-point mode Melukis titik-titik yang ada ke dalam 

koordinat-koordinat bulat terdekat. 
Enable deletion by 
redrawing 

Mempertahankan fungsi mouse yang telah 
dilakukanuntuk penggambaran ulang 

Randomize sliding 
points 

Mengacak letak titik yang ada pada ruas 
garis atau 
Lingkaran 

Help Menampilkan informasi tentang menu Btns 
 

10. View 
Menu View memuat beberapa sub menu tentang tampilan 

gambar yang kita buat. Keterangan tentang menu View dapat dilihat 
dalam Tabel di bawah ini : 

 
Submenu Fungsi 

Window Menempatkan  
gambar di tengah-tengah jendela 

View Mengatur titik tengah dan lebar jendela 
Zoom 
 
In 
Out 
Factor 
 

Memperbesar atau memperkecil tampilan 
gambar, submenu berikut: 
Memperbesar tampilan gambar 
Memperkecil tampilan gambar 
Memperbesar atau memperkecil tampilan 
gambar dengan memasukkan faktor dilatasi 

Shift Mengeser gambar , submenu berikut: 
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Submenu Fungsi 
Right 
Left 
Up 

Down 
Percentage 
 

Mengeser gambar ke kanan 
Mengeser gambar ke kiri 
Mengeser gambar ke atas 

Mengeser gambar ke bawah 
Mengatur prosentase pergeseran gambar 
dengan layar 

Last window Mengembalikan jendela pada pengaturan 
sebelumnya 

Grid 
 
axes 
ticks 

interval 
scale 
places 

frequency 
 
pi 

arrows 
dots 
labels 

tick length 
rectangular 
grid 
polar grid 
apply 

Mengatur tampilan bidang koordinat dan kisi-
kisinya, submenuberikut: 
Pilihan menampilkan sumbu 
Pilihan menampilkan tanda strip pada 
sumbu 
Jarak antara dua tanda strip 
Pilihan menampilkan bilangan pada strip 

tempat desimal yang diinginkan untuk 
bilangan pada strip 
pilihan jarak bilangan yang ditampilkan 
pada strip (1= setiap strip) 
pilihan menampilkan bilangan pada strip 
dalam pi 
pilihan menampilkan tanda panah pada 
ujung sumbu koordinat 
pilihan menampilkan tanda putus-putus 
pada kisi koordinat 
pilihan menampilkan label sumbu koordinat 
mengatur panjang strip pada sumbu 
koordinat 
pilihan menampilkan koordinat kartesius 
siku-siku 
pilihan menampilkan koordinat kutup 
memerintahkan pilihan yang telah 
dilakukan 

Axes 
 
Axes 

Color 
Screen 
thickness 

Menampilkan dan mengatur pilihan sumbu 
koordinat, sub menu 
berikut: 

Menampilkan sumbu koordinat 
Mengatur warna sumbu koordinat 

Mengatur ketebalan sumbu koordinat 
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Submenu Fungsi 
Printed 
thickness 
Label font 

Mengatur ketebalan sumbu koordinat saat 
diprint 
Mengatur font label label sumbu koordinat 

Gridlines 
Color 
Screen 
thickness 
Printed 
thickness 
 

Memodifikasi ketebalan dan warna ruas kisi-
kisi bidang koordinat 
Mengatur warna kisi koordinat 

Mengatur ketebalan kisi koordinat 
Mengatur ketebalan kisi koordinat saat 
diprint 

Help Menampilkan informasi tentang menu View 
 

11. Anim 
Menu Anim digunakan untuk menjalankan animasi yang telah 

dibuat. Bentuk animasi tergantung pada perintah lain yang 
dimasukan seperti pada menu Transf. Keterangan tentang menu 
Anim dapat dilihat dalam Tabel 1.3.11 di bawah ini. 

 
Submenu Fungsi 

# slider 
 
Set L 
 
Set R 
 
reverse 

cycle 
forward 
 
time 
vert at 
stop at 

Mengatur dan menjalankan animasi yang dibuat 
menggunakan 
# slider, dengan submenu berikut 
Mengatur nilai parameter paling kecil / paling 
kiri (untuk 
slide bar) 
Mengatur nilai parameter paling besar / 
paling kanan (untuk 
slide bar) 
Menjalankan animasi dengan mode mundur 
secara bolak-balik 
Menjalankan animasi dengan mode maju 
secara bolak-balik 
Menjalankan animasi dengan mode berulang 
secara terus 
menerus 
Menjalankan animasi dengan menurut waktu 
(1 unit perdetik) 
Mengatur titik yang akan mempunyai jejak 
dalam animasi 
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Submenu Fungsi 
Menghentikan animasi pada parameter 
tertentu yang diberikan. 

$ slider Mengatur dan menjalankan animasi yang dibuat 
menggunakan$ slider. 

@ slider Mengatur dan menjalankan animasi yang dibuat 
menggunakan 
@ slider. 

& Slider Mengatur dan menjalankan animasi yang dibuat 
menggunakan 
& slider. 

% slider Mengatur dan menjalankan animasi yang dibuat 
menggunakan 
% slider. 

? slider Mengatur dan menjalankan animasi yang dibuat 
menggunakan 
? slider. 

t slider Mengatur dan menjalankan animasi yang dibuat 
menggunakan t 
slider. 

Calibrate 
scrollbar 

Mengatur langkah gerakan scrollbar pada menu 
Anim. 

Autopilot link Menjalankan dua atau lebih slider bersama-sama. 
Tracing Mengatur jejak hasil suatu gerakan titik pada 

animasi 
Retrace Menggambar kemabali semua tracing yang sudah 

dibuat 
Monitor 
tracings 

Melihat kembali tracing yang telah dilakukan 

Temporary 
tracing 

Membuat hasil tracing yang sifatnya sementara 
(tidak disimpan) 

Color Memberi warna jejak pada tracing yang dibuat 
Graph window Menampilkan jendela graph window (hanya 

dapat difungsikan 
jika paling sedikit ada dua ukuran pada menu 
meas yang dilawankan) 

Help Menampilkan informasi tentang menu Anim 
 

12. Other 
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Menu other memuat beberapa sub menu tambahan yang berisi 
aksesoris tampilan. Keterangan lebih lengkap tentang menu Other 
dapat dilihat dalam Tabel di bawah ini.  

Submenu Fungsi 
List Menampilkan daftar unsur-unsur yang 

terdapat dalam bangun datar yang telah kita 
buat antara lain titik-titik, ruas garis, 
lingkaran, langkah-langkah pengerjaan dan 
membuat catatan. 

Point 
Lines 
Circles 
 
History 
 
Notebook 

Menampilkan koordinat titik yang telah 
dibuat 
Menampilkan persamaan garis yang telah 
dibuat 
Menampilkan titik pusat panjang jari-jari 
dan persamaan lingkaran yang telah dibuat 
Menampilkan keterangan tentang 
pengerjaan yang telah dilakukan 
Membuat catatan 

3D solid Melukis prisma atau limas dengan 
segibanyak yang ditentukansebagai alas 

Prism 
 
Pyramid 

Menggambar prisma dengan bangun 
datar yang dipilih sebagai alas 
Menggambar limas dengan bangun datar 
yang dipilih sebagai alas 

Fonts Mengatur font yang ingin ditampilkan pada 
submenu berikut 

Measurements 
ASCII values 
Tables and lists 
Scale on axes 
Pi symbol 

Mengatur font untuk measurement 

Mengatur nilai ASCII untuk simbol-simbol 
tertentu 
Mengatur font untuk tables dan list 

Mengatur font untuk bilangan pada 
sumbu koordinat 
Mengatur nilai ASCII untuk simbol pi 

Colors 
Background 
Bounce 
Measurement 
Dotted lines 
Color them 
Fill mix modes 

Memilih warna yang kita inginkan pada 
submenu berikut: 
Memilih warna latar belakang 

Memilih warna bounce 
Memilih warna untuk font measurement 
Memilih warna untuk garis putus-putus 

(tidak ada keterangan) 
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Submenu Fungsi 
_ Opaque 
_ XOR 
_ Not XOR 
_ Lunch 
 

(tidak ada keterangan) 
(tidak ada keterangan) 
(tidak ada keterangan) 

(tidak ada keterangan) 
(tidak ada keterangan) 

Measurement 
 
Home positions 
 
Show unit 

Mengatur letak tampilan dan satuaan ukuran 
dari menu meas, submenu berikut 
Mengatur letak tampilan besaran dari 
meas di posisi awal (kiri atas) 
Menampilkan satuaan besaran dari meas. 

 
13. Help 

Menu help menampilkan beberapa catatan umum tentang 
program Wingeom untuk geometri dimensi dua (2-dim). Jendela 3-
dim, (program Wingeom untuk geometri dimensi tiga), menyediakan 
beberapa menu yang dapat dilihat pada bagian dimensi dua dan tiga. 
Ada 13 menu dalam jendela 2-dim, yang telah dibahas sebelumnya 
secara ringkas. 
 

LATIHAN1 

Untuk memperdalam pemahaman mengenai materi diatas, 
kerjakanlah latihan berikut yang berkaitan dengan titik, garis, dan 
sudut, segitiga, selanjutnya lingkaran dan irisan kerucut! 

 
1. Titik, garis, dan sudut 

 Menggambar sebarang titik 
Untuk menggambar titik terlebih dulu harus diaktifkan fungsi 

klik untuk Segment, dengan cara:  

o Klik Btns>Segments ATAU  
o Klik Btns>Toolbar, maka akan muncul jendela toolbar, 

kemudian pilih submenu Segments. Kemudian lakukan klik 
kanan pada bidang gambar di tempat yang diinginkan, maka 
akan muncul noktah dan label (huruf) dari titik yang dibuat. 
Kondisi awal noktah berupa lingkaran kecil lubang. Lakukan 
beberapa kali untuk membuat beberapa titik. Tampilan yang 
akan muncul seperti terlihat pada gambar 3 berikut: 
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Gambar 1-3 

Menggambar titik 
 

 Menggambar titik dengan koordinat tertentu 
Untuk menggambar titik dengan lokasi tertentu dapat 

dilakukan dengan menentukan koordinatnya. Adapaun langkah-
langkah yang dilakukan adalah sebagai berikut: 

o Klik Point>Coordinate, maka akan muncul subjendela untuk 
mengisikan nilai x dan y. Dalam cara ini sumbu koordinat 
akan otomatis tampil. Tampilan koordinat dapat diatur 
melalui menu View>Grid. Untuk lebih jelasnya dapat dilihat 
pada gambar 4 berikut: 

 

 

Gambar 1-4 
Menggambar titik 
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Untuk mengubah bentuk titik dapat dilakukan dengan: 

o Klik Edit>Labels>Dot mode, ATAU dengan menekan Ctrl+D 
pada keybord.Lakukan berulang-ulang sampai untuk memilih 
bentuk titik yang diinginkan.  
Untuk mengubah font label dapat dilakukan dengan:  

o Klik Edit> Labels>Font, akan muncul jendela vertex label, 
pilih font yang diinginkan.  
Untuk mengubah warna label dapat dilakukan dengan:  

o Klik Edit>Labels>Color, akan muncul jendela label, pilih 
warna yang diinginkan, dengan cara klik pada warna.  
Agar Label titik dapat digeser dengan kursor dengan cara: 

o Klik Btns>Toolbar, kemudian pilih Text Edit.  
Kemudian klik pada label, tahan sambil digeser ke tempat 
yang diinginkan. Hal ini diperlukan jika label tertutup gambar 
yang lain, yang mungkin akan dijumpai pada bagian 
selanjutnya. Gambar berikut merupakan contoh modifikasi 
titik dengan font Book Antiqua dan size font 16 serta warna 
(colour) yang digunakan adalah merah. 
 

 

Gambar 1-5 
Modifikasi titik 

 

 Menghapus titik 
 Untuk menghapus titik dapat dilakukan dengan:  
o Klik Edit>Delete>Point , ketikan label titik yang akan di 

hapus pada kotak dialog (bisa satu demi satu atau beberapa 
sekaligus), lalu klik ok. Dalam proses menggambar kita tidak 
selalu harus menghapus titik yang sudah digambar kalau 
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melakukan kesalahan atau hal yang tidak inginkan, tetapi 
dapat menggunakan klik Edit>Undo atau Ctrl Z.  

 Menuliskan Text  
Menuliskan text pada gambar kadang diperlukan untuk 

memberikan judul maupun keterangan-keterangan yang diperlukan. 
Untuk menuliskan text terlebih dulu harus diaktifkan fungsi klik 
untuk text edit, dengan cara:  

o Klik Btns>Text ATAU  
o Klik Btns>Toolbar, maka akan muncul jendela toolbar, 

kemudian pilih submenu text edit.  
Lakukan klik kanan di lokasi yang diinginkan pada bidang 
gambar, maka akan muncul jendela edit text. Isikan text 
yang diinginkan pada tempat bagian atas, pilih font yang 
diinginkan dengan klik font, klik ok. Gambar berikut 
merupakan contoh edit text yang digunakan untuk 
menggambar sebarang titik. 

 

Gambar 1-6 
Menuliskan text 

 
Text yang muncul pada layar utama dapat digeser dengan 
klik pada text, tahan dan geser ke tempat yang diinginkan. 
Untuk menghapus text dapat dilakukan dengan klik kanan 
pada text, kemudian hapus text pada jendela, klik ok.  
 

 Menggambar Ruas Garis  
Pastikan submenu Segments pada submenu Btns sudah aktif, 

dengan cara:  

o Klik Btns>Segments ATAU 
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Klik Btns>Toolbar, maka akan muncul jendela toolbar, 
kemudian pilih submenu segments. Dari sembarang dua titik 
yang sudah dibuat dapat dilukis ruas garis dengan cara: Klik 
pada salah satu titik, tahan dan geser hingga ujung mouse 
menyentuh titik lainnya lalu lepaskan. Cara lain yang dapat 
dilakukan adalah:  

o Klik Line>Segment, muncul jendela new segment, lalu isikan 
dua titik yang dimaksud (misalkan: AB).  
Untuk mengubah tebal, warna dan bentuk ruas garis dapat 
dilakukan dengan cara:  

o Klik Edit>Highlights>Line attributes, akan muncul jendela 
line attributes.  

o Isikan pada lines dengan label garis yang diinginkan, 
misalkan AB,  

o Isikan pada thickness dengan bilangan 1 atau 2 atau 3 dan 
seterusnya,  

o Klik color, akan muncul jendela color, pilih warna yang 
diinginkan,  

o Klik style untuk bentuk yang diinginkan, di samping tombol 
style akan muncul tulisan berganti-ganti: solid (tegas), doted 
(titik-titik), dashed (strip-strip), dot-dash (titik-strip), dot-
dash-dot (titik-strip-titik) dan invisible (tidak nampak).  

o Pilihan style ini akan berfungsi untuk selain bentuk solid jika 
thickness berisi 1.Contoh hasilnya dapat dilihat pada 
Gambar7. 

 Menghapus ruas garis. 
Untuk menghapus ruas garis dapat dilakukan dengan:  

o Klik Edit>Delete>Line , ketikan label garis yang akan di 
hapus pada kotak dialog, misal: AB, lalu klik ok. Berikut 
tampilan ruas garis AB yang dapat dilihat pada gambar 7 
dibaah ini: 
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Gambar 1-7 
Menggambar Ruas Garis AB 

 

 Menggambar Dua Garis Sejajar  
Menggambar dua garis sejajar dapat dilakukan dengan cara 

berikut.  

o Mula-mula lukislah sebuah garis, misalkan garis AB.  
o Lukislah sembarang titik di luar garis tersebut, misalkna titik 

C.  
o Selanjutnya dilukis garis yang sejajar garis AB dan melalui 

titik C, dengan cara: klik: Line>Parallels, maka muncul 
jendela draw parallel.  

o Isilah parallel to dengan AB dan through point dengan C, 
lalu klik draw.  

o Kita peroleh garis CD yang sejajar dengan garis AB, seperti 
pada Gambar 8. 
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Gambar 1-8 
Menggambar Garis sejajar 

 
2. Segitiga, Lingkaran dan Irisan Kerucut 

Tugas bagi mahasiswa sebagai latihan! 
 

 
 

⌂ 
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BAB 2 
TITIK DAN JARAK  

DIANTARA DUA TITIK 
 
 

Tujuan Pembelajaran 
Dalam modul ini mahasiswa akan mempelajari titik dan vektor 

bidang melalui kegiatan belajar 2. Setelah membaca dan mengikuti 
perkuliahan mahasiswa diharapkan dapat: 

1. Menentukan titik pada garis bilangan dan koordinat 
2. Mengetahui simetri sebuah titik pada segmen garis 
3. Melukis dan menentukan jarak diantara dua titik 

 
KEGIATAN BELAJAR 1 

 Garis Bilangan dan Koordinat 
Titik yang terletak pada garis bilangan dapat dinyatakan 

dengan bilangan bilangan. Untuk menentukan suatu titik pada garis, 
maka terlebih dahulu kita buat skala bilangan. Dengan menggunakan 
wingeom software skala bilangan dapat dinyatakan dengan langkah 
sebagai berikut: 

- Buka program wingeom software, pilih windows 
- Klik Btns pilih segment 
- Klik View pilih grid kemudian akan muncul tampilan sebagai 

berikut 

 
Gambar 2-1 

Kemudian pilihlah pilihan yang ada seperti gambar diatas 
sehingga muncul tampilan garis bilangan sebagai berikut: 



P e n g a n t a r  G e o m e t r i  A n a l i t i k  

26 Mutia Fonna|Mursalin 

 

 
Gambar 2-2 

 
Skala bilangan pada gambar diatas ditentukan sebagai berikut: 

1. Titik O sebagai titik pangkal atau titik pusat 
2. Untuk menentukan sebuah titik misal titik A, panjang segmen 

OA sebagai satu satuan panjang 
3. Untuk menentukan arah positif dapat ditinjau dari sebelah 

kanan titik O (titik pangkal). Sebaliknya untuk menentukan 
arah negatif dapat ditinjau dari sebelah kiri titik pangkal. Misal 
arah negatif dari sebelah kiri titik O, jadi bila pada titik O 
dibubuhi angka nol, maka pada titik C kita bubuhi -2. Misal arah 
positif dari sebelah titik O, jadi bila pada titik O dibubuhi angka 
nol maka pada titik B kita bubuhi +4 atau 4. 

Bilangan-bilangan yang terdapat pada setiap titik di garis x 
disebut koordinat titik, dan garis x disebut sebagai garis 
bilangan.Cara menyatakan titik misal pada gambar 10 di atas 
yaitu, O (0), A(1), B(4), C(-2), D(-4).  

Contoh 1: 
Tentukanlah koordinat dan gambarlah titik pada garis x dari 
persamaan berikut 3x+12 = 0!  

Penyelesaian : 
Dari persaman 3x+12 = 0 diperoleh 3x=-12, jadi x = - 4, maka 
titik yang didapat adalah titik D(-4), (lihat gambar 10) 

Contoh 2: 
Tentukanlah koordinat dan gambarlah titik pada garis x dari 
persamaan berikut x+5x = 0!  
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Penyelesaian : 
Dari persaman x+5x = 0 diperoleh 6x= 0, jadi x = 0, maka titik 
yang didapat adalah titik O(0), (lihat gambar 10). 

 
Dalam geometri analitik bidang, untuk menentukan letak suatu 

titik pada bidang datar dapat dilakukan dengan membuat dua buah 
garis bilangan yang berpotongan dititik pangkal O. Kedua garis 
bilangan berpotongan dititik pangkal O membentuk sudut 90o, maka 
sistem koordinat ini dinamakan sistem koordinat cartesius 
(selanjutnya dinamakan dengan salib sumbu). Garis yang mendatar 
(horizontal) dinamakan dengan sumbu X, sedangkan garis tegak 
(vertikal) dinamakan sumbu Y.  

 
Gambar 2-3 

Perhatikan gambar 2-3 diatas:  

1. Bagian sebelah kanan titik pangkal dari sumbu X adalah positif, 
sedangkan bagian sebelah kiri titik pangkal pada sumbu X 
negatif 

2. Bagian atas titik pangkal dari sumbu Y adalah positif, 
sedangkan bagian bawah titik pangkal pada sumbu Y adalah 
negatif 

3. Tinjau titik A pada gambar diatas. Untuk menentukan letak titik 
A ditarik garis tegak lurus, AB tegak lurus sumbu X dan AC 
tegak lurus sumbu Y, sehingga diperoleh titik A dari pangang 
OB dan OC. 

4. Panjang OB dinamakan absis titik A dan panjang OC dinamakan 
ordinat titik A.  
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5. Absis dan ordinat sebuah titik dinamakan koordinat titik itu. 
Suatu koordinat titik dituliskan dengan x dan y, misal koordinat 
titik A(x,y). Titik-titik disebelah kanan sumbu Y mempunyai 
absis positif, sedangkan disebelah kiri sumbu Y mempunyai 
absis negatif. Titik-titik disebelah atas sumbu X mempunyai 
ordinat positif, sedangkan dibawah sumbu Y mempunyai 
ordinat negatif. Perhatikan gambar 2-3 diatas, letak titik-titik 
tersebut yaitu: A(3,2), B(3,0), C(2,0).  

6. Kedua sumbu, yaitu sumbu X dan sumbu Y membagi bidang 
menjadi empat bagian atau disebut juga dengan kwadran. 
Perhatikan gambar 2-4 di bawah ini: 

 
Gambar 2-5 

Pada gambar 2-5 diatas tanda dari absis dan ordinat suatu 
titik pada kwadran adalah sebagai berikut: 

Kwadran Absis Ordinat 
I + + 
II - + 
III - - 
IV + - 

 Simetri  
Dua titik P dan Q dikatakan simetri terhadap titik O (lihat 

gambar 2-6), dengan O adalah titik tengah segmen yang 
menghubungkan titik P dan Q. Kedua titik P dan Q disebut bayangan-
bayangan yang saling simetri terhadap titik O. Sedangkan titik O 
disebut pusat simetri.  
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Gambar 2-6  

Untuk melihat dua titik P dan Q simetri terhadap garis g dengan 
g adalah garis tegak lurus yang membagi dua sama panjang segmen 
garis PQ. Titik P dan Q merupakan bayangan-bayangan yang saling 
simetri terhadap garis g dan garis g disebut sebagai sumbu simetri 
dari titik P dan Q (lihat gambar 2-7). 

 

 
Gambar 2-7 

Contoh 3: 
Carilah koordinat-koordinat titik yang simetri dengan titik 
(3,3) terhadap titik pangkal, sumbu X dan sumbu Y! 

Penyelesaian : 
Perhatikan gambar 2-8 berikut untuk menentukan titik (3,3) 
simetri terhadap titik pangkal, diperoleh titik (-3,-3). Titik (3,3) 
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simetri terhadap sumbu X dengan (3,-3). Selanjutnya titik (3,3) 
simetri terhadap sumbu Y dengan (-3,3).  

 
Gambar 2-9 

 Jarak Diantara Dua Titik 
Perhatikantitik B (x1, y1) dan C (x2, y2)terletak pada bidang. 

Untuk menghitung jarak antara titik B dan C yang koordinatnya 
diketahui seperti pada gambar 2-10 berikut adalah dengan cara 
memperhatikan segitiga siku-siku BDC, dimana BD=(x2-x1) dan DC= 
(y2- y1).  

 
Gambar 2-10 

Menurut dalil Pythagoras : 
BC2 = BD2+DC2 

=  

BC  =  , atau 
 
 Ket: d = jarak d =  
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 Jarak diantara dua titik adalah akar kuadrat dari kuadrat 
jumlah komponen-komponen skalar segmen garis hubung kedua titik 
tersebut. Sedangkan yang dimaksud dengan jarak adalah jarak yang 
selalu bernilai positif (mutlak).  

Contoh 4: 
Dari soal berikut carilah jarak diantara dua titik dengan 
koordinat (-4, 3) dan (5,-2) ! 

Penyelesaian : 
Jarak diantara dua titik dengan koordinat (-4,3) dan (5,-2) 
adalah :  

 

 

Jadi: d =  

d =  

d =  

d =  
 
Rangkuman: 

1. Sistem koordinat cartesius (salib sumbu) yaitu sistem 
koordinat dimana kedua garis bilangan berpotongan dititik 
pangkal O membentuk sudut 90o. 

2. Garis yang mendatar (horizontal) dinamakan dengan sumbu X, 
sedangkan garis tegak (vertikal) dinamakan sumbu Y. Suatu 
koordinat titik dituliskan dengan x dan y, misal koordinat titik 
A(x,y). Titik-titik disebelah kanan sumbu Y mempunyai absis 
positif, sedangkan disebelah kiri sumbu Y mempunyai absis 
negatif. Titik-titik disebelah atas sumbu X mempunyai ordinat 
positif, sedangkan dibawah sumbu Y mempunyai ordinat 
negatif.  

3. Dua titik P dan Q dikatakan simetri terhadap titik O dengan O 
adalah titik tengah segmen yang menghubungkan titik P dan Q. 
Kedua titik P dan Q disebut bayangan-bayangan yang saling 
simetri terhadap titik O. Sedangkan titik O disebut pusat 
simetri.  

4. Dua titik P dan Q simetri terhadap garis g dengan g adalah garis 
tegak lurus yang membagi dua sama panjang segmen garis PQ. 
Titik P dan Q merupakan bayangan-bayangan yang saling 
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simetri terhadap garis g dan garis g disebut sebagai sumbu 
simetri dari titik P dan Q.  

5. Jarak diantara dua titik adalah akar kuadrat dari kuadrat 
jumlah komponen-komponen skalar segmen garis hubung 
kedua titik tersebut. Sedangkan yang dimaksud dengan jarak 
adalah jarak yang selalu bernilai positif (mutlak).  

6. Jarak diantara dua titik dapat ditentukan dengan: 

d =  

 
 LATIHAN 2 

1. Jekaskan yang dimaksud dengan istilah berikut: 
a. Absis 
b. Ordinat 
c. Koordinat suatu titik 
d. Jarak 

2. Gambarlah titik-titik dibawah ini dengan berbantuan 
wingeom software! 
a. A (-2,0) 
b. B (-4, -6) 
c. C (5, 5) 
d. D (3,-3) 

3. Suatu segitiga sama sisi dua titik sudutnya adalah (0,0) dan 
(a,0). Tentukan letak titik sudut yang ketiga! 

4. Tentukanlah bayangan dari titik M (-3,2) terhadap sumbu X, 
sumbu Y dan bayangan terhadap titik pangkal! 

5. Carilah panjang segmen PQ dengan koordinat P (1,-5) dan Q 
(-2, -1)! 

6. Berapakah luas segiempat jika diketahui titik-titik puncak 
(5,3), (5,-1), (0,3), (0,-1) ? 

7. Carilah keliling segitiga dengan koordinat titik puncak (7,1) , 
(-2,-4) dan (-3, 5) ! 

8. Tentukan jarak antara (-2,3) dengan titik tengah potongan 
garis yang digabungkan (-2,-2) dan (4,3)! 

 

⌂ 
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BAB 3 
PERSAMAAN GARIS 

 

Tujuan Pembelajaran 
Dalam modul ini mahasiswa akan mempelajari gradien dan 

persamaan garis lurus melalui sebuah titik pada kegiatan belajar 1 
dan persaman garis lurus melalui dua buah titik pada kegiatan 
belajar 2. Setelah membaca dan mengikuti perkuliahan mahasiswa 
diharapkan dapat: 

1. Mengetahui definisi gradien pada suatu ruas garis 
2. Menentukan gradien jika diketahui titiknya 
3. Mengetahui dan menentukan persamaan garis lurus melalui 

titik asal O (0,0) 
4. Mengetahui dan menentukan persamaan garis lurus dengan 

gradien m dan O (0,c) 
5. Mengetahui dan menentukan persamaan garis lurus melalui 

titik (x1,y1) dan gradien m 
6. Mengetahui dan menentukan persamaan garis lurus melalui 

dua buah titik 
7. Mengetahui dan menentukan persamaan garis lurus melalui 

titik (a,0) dan (0,b) 
8. Mengetahui dan menentukan dua buah garis lurus yang sejajar 

dan tegak lurus 
 
KEGIATAN BELAJAR 1 

 Gradien 
Kata garis adalah kata lain dari garis lurus. Sebuah garis adalah 

sebuah objek geometri. Dalam banyak hal garis lurus adalah yang 
paling sederhana dari semua kurva. Bila ditempatkan pada suatu 
koordinat bidang, garis ini tentulah mempunyai persamaan. 
Bagaimana kita mencari persamaan suatu garis? Untuk menjawabnya 
kita memerlukan pengertian yang mendasar tentang kemiringan. 
Kemiringan suatu garis disebut dengan gradien (koefisien 
arah=slofe). Perhatikan gambar dibawah ini:  
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Gambar 3-1 

Gradien atau kemiringan m dari garis BC didefinisikan sebagai 
hasil bagi komponen y dari BC oleh komponen x dari BC. Jika titik B 

(x1,y1) dan titik C (x2,y2), maka gradien dari garis BC ( ) berlaku: 
  
 

 

Keterangan : Gradien  

 Komponen y (perubahan tegak) 

 Komponen x (perubahan mendatar) 
 

Gradien madalah ukuran kecuraman suatu garis. Garis 
mendatar mempunyai kemiringan 0. Apabila suatu garis naik dari 
kiri kekanan, maka gradiennya positif. Apabila suatu garis turun dari 
kiri kekanan maka gradiennya negatif. Semakin besar kemiringan 

suatu garis semakin curam garis tersebut. Apabila  atau 

, untuk garis tegak maka gradien atau kemiringan garis 
tidak dapat didefinisikan.  

Contoh 1: 
Carilah kemiringan garis jika diketahui titik M (1,-3) dan N(-4,-
2)! 

Penyelesaian: 
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 Persamaan garis lurus melalui titik asal O (0,0) 
 

 
Gambar 3-2 

Perhatikan gambar 3-2 diatas. Garis g melalui titik asal O (0,0) 
dan titik A (x,y). Jika α sama dengan sudut antara garis g dengan 
sumbu X, maka gradien garis g adalah:   

  
 

Apabila tan  dinyatakan dengan m, maka bentuk umum 
persamaan garis lurus yang melalui titik asal O (0,0) menjadi:  

 

  Keterangan:  m = gradien  
 

Contoh 2: 
Tentukan persamaan garis lurus yang melalui titik asal O(0,0) 
dengan gradien 6! 

Penyelesaian: 
Persamaan garis lurus melalui titik asal O(0,0) adalah y = m x. 
Jika diketahui m=6 maka persamaan garis tersebut menjadi y = 
6x 

 
 

 

 



P e n g a n t a r  G e o m e t r i  A n a l i t i k  

36 Mutia Fonna|Mursalin 

 

 Persamaan garis lurus dengan gradien m dan melalui titik O 
(0, c) 

 

 
Gambar 3-3 

Persamaan suatu garis dapat dinyatakan dalam bermacam 
bentuk. Andaikan diberikan kemiringan muntuk suatu garis dan c 
perpotongan sumbu Yartinya garis memotong sumbu Y di (0,c). 
Perhatikan gambar 3-3 diatas. Garis g ditarik melalui titik P (0,c) dan 
titik Q(x,y) maka gradien atau kemiringan garis tersebut menjadi: 

 
 
 

atau :  
 
 
dengan demikian bentuk umum persamaan garis lurus dengan 
gradien m dan melalui titik (0,c), yaitu :  
 
 
Contoh 3: 

Carilah persamaan garis lurus berikut, kemudian tulislah 
jawaban anda dalam bentuk Ax+By+C=0 (persamaan linear 
umum) dengan perpotongan sb-Y 4 dan kemiringan -2! 
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Penyelesaian: 
Untuk menentukan persamaan tersebut, tinjau titik 
perpotongan sumbu Y yaitu 4 dengan demikian diperoleh titik 
c= 4. Dengan gradien -2, maka persamaan garis diperoleh: y = -
2x+4 
atau: -2x - y + 4=0 

 

 Persamaan garis lurus melalui titik (x1,y1) dan gradien m 
 

 
Gambar 3-4 

Perhatikan garis g pada gambar 3-4 di atas. Tinjau titik S(x,y) 
yang terletak pada garis g, maka persamaan garis g yang melalui titik 
R (x1,y1) dan titik S(x, y), gradiennya kita peroleh:  
 
 
 
Sehingga persamaannya menjadi:  
  

Contoh 4: 
Carilah persamaan garis yang melalui (3,-4) dan gradiennya 4! 

Penyelesaian: 
Persamaan garis tersebut adalah : y-(-4)   = 4 (x-3) 

     y+4  = 4x-12  
  y  = 4x-16 
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KEGIATAN BELAJAR 2 

 Persamaan garis melalui dua buah titik 
Andaikan garis g melalui titik R (x1,y1) dan titik S(x2,y2), maka 

didapat: 
 

  . . . . . . . . . . . . (1) 
 

Rumus persamaan garis melalui titik (x1,y1) adalah :  
 
 .. . . . . . . . . .(2) 
 

Dari persamaan (1) dan (2) diperoleh: 
 
 atau:  

 

Contoh 5: 
Carilah persamaan garis yang melalui (-5,0) dan gradiennya (-
6,4)! 

Penyelesaian: 
Persamaan garis tersebut adalah :  

 
 
 
 

 

 
 

 
 Persamaan garis yang melalui titik (a,0) dan (0,b) 

Persamaan garis yang melalui titik(a,0) dan (b,0) berdasarkan 
rumus persamaan garis melalui dua buah titik adalah: 
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  atau  
 
Persamaan garis diatas disebut dengan persamaan garis sigmen. 
 

 Dua garis sejajar 
 

 
Gambar 3-5 

Jika dua garis mempunyai kemiringan sama, maka keduanya 
sejajar. Garis m sejajar dengan garis n (lihat gambar 3-5) maka:  

 
 

Sehingga  
 
Jadi :  
 

Contoh 6: 
Tentukan persamaan garis yang melalui titik (3,-3) yang sejajar 
garis y = 2x+5 

Penyelesaian: 
Garis y = 2x+5, maka diperoleh m1 = 2. Dua buah garis 

dikatakan sejajar jika . Sehingga diperolehm1 = m2 = 
2. Persamaan garis yang diminta menjadi:  
y-(-3) = 2 (x-3)  
y + 3 = 2x-6 
y = 2x -9 

 

:  
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 Dua garis tegak lurus 
 

 
Gambar 3-6 

Dua garis tak vertikal saling tegak lurus jika dan hanya jika 
kemiringan keduanya saling berkebalikan negatif. Untuk melihat 
mengapa ini benar, pandang dua garis tak vertikal k dan l. 
Berdasarkan gambar diatas perpotongan dititik asal, kita dapat 
menggeser sedemikian rupa sehingga tidak mengubah 
kemiringannya. Andaikan A (x1, y1)terletak pada garis k, C (x2, y2) 
terletak pada garis l seperti terlihat pada gambar 3-6. Berdasarkan 
Teorema Phytagoras: 
AC2 = OA2+ OC2 

, setelah 
penyederhanaan persamaan menjadi: 

 

 

 

 
Karena y1/x1=m1 adalah kemiringan garis k dan y2/x2 =m2adalah 
kemiringan garis l dan keduanya saling tegak lurus, maka diperoleh : 

 
 
 



P e r s a m a a n  G a r i s  

41 Universitas Malikussaleh 

 

Rangkuman: 
1. Kemiringan suatu garis disebut dengan gradien (koefisien 

arah=slofe). 
 
2. Jika titik B (x1,y1) dan titik C (x2,y2), maka gradien dari garis 

BC ( ) berlaku: 
 

3. Bentuk umum persamaan garis lurus yang melalui titik asal O 
(0,0)  adalah :  

 
4. Bentuk umum persamaan garis lurus dengan gradien m dan 

melalui titik (0,c), yaitu :  
 

5. Persamaan garis lurus melalui titik (x1,y1) dan gradien m 
adalah: 

 
6. Persamaan garis lurus melalui dua buah titik, jika dua buah 

titik yang diketahui (x1,y1) dan (x2,y2) yaitu :  
 
 
 
 

7. Persamaan garis yang melalui titik(a,0) dan (b,0) yaitu:  
 
 
 

8. Jika dua buah garis saling sejajar maka: 
 
9. Jika dua buah garis berpotongan saling tegak lurus maka:  
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 LATIHAN 3 

 

1. Carilah persamaan garis berikut jika: 
a.   Melalui titik (0,0) dan (-2,6) 
b.   Melalui titik (0,0) dan (3,-15) 

2. Diketahui segitiga ABC dengan puncak A (1,0) , B (3,4) , C (5,-2). 
Carilah persamaan dari masing-masing sisinya! 

 
3. Carilah kemiringan dan perpotongan –Y untuk persamaan garis  

4x+5y=-20! 

 
4. Tuliskan persamaan garis melalui (3,-3) yang: 

a. Sejajar garis 2x+3y=6 
b. Tegak lurus garis y=2x+5 
c. Sejajar garis yang melalui (-1,2) dan (3,-1) 
 

5. Carilah koordinat titik potongnya. Kemudian tuliskan 
persamaan garis yang melalui titik tersebut tegaklurus pada 
garis yang pertama. 
2x+3y=4 
-3x+y=5 

 
6. Berapakah nilai p jika garis px-3y=10 sejajar garis y=2x+4? 
 
7. Carilah nilai k jika diketahui garis 4x+ky=5 melalui titik (2,1)! 
 
8. Tentukanlah letak titik (3,9), apakah terletak diatas atau di 

bawah garis y=3x-1! 
 

⌂ 
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BAB 4 
LINGKARAN 

 

Tujuan Pembelajaran 
Dalam modul ini mahasiswa akan mempelajari lingkaran dan 

persamaan lingkaran, serta persamaan garis singgung lingkaran pada 
kegiatan belajar 1 Setelah membaca dan mengikuti perkuliahan 
mahasiswa diharapkan dapat: 

1. Mengetahui definisi lingkaran 
2. Menggambar lingkaran jika diketahui titik pusat lingkaran dan 

jari-jari lingkaran 
3. Menentukan persamaan lingkaran 
4. Menentukan persamaan garis singgung lingkaran 

 
KEGIATAN BELAJAR 1 

 Persamaan Lingkaran 
Lingkaran adalah tempat kedudukan titik-titik pada bidang 

datar, sehingga setiap titik pada lingkaran itu berjarak sama 
terhadap titik tertentu dalam lingkaran. Jarak yang sama disebut 
dengan jari-jari (radius) sedangkan titik tertentu disebut pusat 
(center) lingkaran.  

 
Gambar 4-1 

Perhatikan gambar 4-1 diatas. P (x,y) ialah titik pada lingkaran 
L dengan pusat O dan jari-jari r, maka: 
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Persamaan lingkaran dengan pusat di titik asal O dan jari-jari r 
adalah ; 
 
 
 

Jika sebuah lingkaran tidak berpusat pada titik asal O (0,0) atau 
bergerak dengan pusat (a,b) dan jari-jari r, maka persamaan 
lingkaran diperoleh sebagai berikut:  
Perhatikan gambar 4-2 dibawah ini: 

 
Gambar 4-2 

Berdasarkan gambar 4-2 diatas titik P(x,y) adalah titik pada 
lingkaran dengan pusat  A(a,b) dan jari-jari r, maka: 

 

 
  

Dengan demikian persamaan lingkaran dengan pusat (a,b) dan 
jari-jari r adalah: 
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Contoh 1: 
Tentukan persamaan lingkaran yang berpusat di titik C (-2,1) 
dan melaui P (1,3)!  

Penyelesaian: 
Untuk menentukan persamaan garis terlebih dahulu 
menentukan jari-jari lingkaran dengan mehitung 

. Karena persamaan lingkaran berpusat di C(-

2,1) maka diperoleh persamaan: 

 

 
 

Persamaan lingkaran yang berpusat di (a,b) sebagaimana telah 
diketahui sebelumnya yaitu:  

, maka jika dijabarkan, persamaan 

tersebut menjadi: 

 
 
Dengan mengganti -2ax dan -2by menjadi 2Ax dan 2By, juga 

a2+b2-r2 = C, bentuk persamaan umum lingkaran diperoleh: 
 
 
 

Persamaan itu merupakan persamaan umum lingkaran, dengan 
pusat (-A,-B) dan  

  

  

 Untuk koefisien x2 dan y2 usahakan sama dengan 1 

Contoh 2: 
Carilah pusat dan jari-jari lingkaran berikut: 

 

Penyelesaian: 
Dari persamaan lingkaran di atas diperoleh: 
2A= -2   A = -1 
2B= 4  B = 2 
C = 1  
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Jadi pusat lingkaran tersebut adalah (-1,2) dan jari-jarinya 

adalah 2. 
 

 Garis dan lingkaran  

1. Titik potong garis lurus dan lingkaran 
Persamaan garis lurus adalah:  

………………………...........(1) 

Persamaan lingkaran adalah: 
………....(2) 

Disubstitusikan (1) ke (2) diperoleh : 

 

 

Sehingga didapat persamaan kuadrat dalam x. Dengan 
memperhatikan diskriminan (D) dari persamaan kuadrat 
tersebut diperoleh hal-hal sebagai berikut: 
1. Jika D>0, maka garis memotong lingkaran pada dua titik 

berlainan. 
2. Jika D<0, maka garis tidak memotong lingkaran. 
3. Jika D=0, maka garis menyinggung lingkaran (garis 

memotong lingkaran pada satu titik /dua titik yang sama). 
 

2. Persamaan garis singgung jika koefisien arah diketahui 
Perhatikan dua garis singgung k1 sejajar k2 dengan koefisien arah 
m yang diketahui. 

 
Gambar 4-3 
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Ambil persamaan lingkaran pada titik pusat O(0,0) yaitu: 
…………….. (1) 

Dan garis: 
   ……………….(2) 

Substitusikan persamaan (2) ke persamaan (1) diperoleh: 

 

 

 
D=0, Maka: 

 
 
 

Berdasarkan nilai c yang diperoleh ada dua harga c yaitu: 

 

Dengan demikian diperoleh dua garis singgung lingkaran 
yaitu: 
 
 
 
 
Jika persamaan umum lingkaran diketahui dan berpusat di 
(a,b), maka dapat kita ubah bentuk:  

 

Dengan mempergunakan traslasi, maka persamaan garis 
singgung pada sumbu baru menjadi: 

 

Dari rumus translasi x’= x-a dan y’= y-b disubstitusikan, 
diperoleh persamaan garis singgung lingkaran yaitu: 
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3. Persamaan garis singgung di suatu titik terhadap lingkaran 
 

 
Gambar 4-4 

Perhatikan gambar 4-4 titik P(x1, y1) terletak pada lingkaran 
 

Maka: ……………………………. (1) 

Persamaan garis  atau 

…………………………………………….(2) 

Karena garis singgung yang melalui P tegak lurus OP, maka 
gradien atau koefisien arah garis adalah :  

Dengan demikian persamaan garis singgung tersebut adalah: 

 

 
 

 
 
 

Dengan cara yang sama untuk lingkaran 
 

dengan titik singgung P (  adalah: 
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Rangkuman: 

1. Lingkaran adalah tempat kedudukan titik-titik pada bidang 
datar, sehingga setiap titik pada lingkaran itu berjarak sama 
terhadap titik tertentu dalam lingkaran. Jarak yang sama 
disebut dengan jari-jari (radius) sedangkan titik tertentu 
disebut pusat (center) lingkaran. 

2. Persamaan lingkaran dengan pusat di titik asal O dan jari-jari 
r adalah  
 
 

3. Persamaan lingkaran dengan pusat (a,b) dan jari-jari r 
adalah: 

 
 

4. Persamaan umum lingkaran yaitu: 
 
 

Persamaan itu merupakan persamaan umum lingkaran, 

dengan pusat (-A,-B) dan   

 

5. Persamaan garis singgung lingkaran jika diketahui gradien m 
dan berpusat di O (0,0) adalah:  

 
 
 

6. Persamaan garis singgung lingkaran jika diketahui gradien m 
dan berpusat di O (a,b) adalah:  
 
 
 

7. Persamaan garis singgung lingkaran yang melalui suatu titik 
P (x1, y1) pada lingkaran  adalah  

 
 
 

8. Persamaan garis singgung lingkaran yang melalui suatu titik 
P (x1, y1) pada lingkaran   adalah  
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LATIHAN 4 

1. Carilah persamaan lingkaran berikut: 
a. Pusat (0,0) dan  

b. Pusat (-5,0) dan  

c. Pusat (4,-1) dan  

d. Pusat (2,4) dan  

e. Titik pusat (0,4) dan melalui titik (0,-4) 
2. Carilah persamaan lingkaran berikut jika diketahui pusat 

(6,4) dan menyinggung sumbu Y! 
3. Tentukanlah persamaan lingkaran yang titik-titik ujung garis 

tengahnya (diameter) dari titik (2,4) dan (-2,7)! 
4. Carilah pusat jari-jari untuk tiap lingkaran berikut dan 

gambarlah grafiknya! 
a.  

b.  

c.  

d.  

5. Sebuah lingkaran dengan pusat (2,-3) dan mnyinggung garis 
3x+4y-4=0, tentukanlah persaman lingkaran tersebut? 

6. Carilah pusat dan jari-jari dari tiap lingkaran berikut: 
a.  

b.  

c.  

7. Tentukanlah persamaan garis singgung lingkaran yang 
melalui titik (3,4) pada lingkaran ! 

8. Tentukanlah persamaan garis singgung lingkaran yang 
melalui titik (-3,-2) pada lingkaran 

! 

9. Carilah persamaan garis yang bergradien 2 dan menyinggung 
lingkaran ! 

10. Tentukanlah persamaan garis singgung lingkaran jika: 
a.  dan tegak lurus garis 

 

b.  dan sejajar garis 
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BAB 5 
PARABOLA, ELIPS, DAN  

HIPERBOLA 
 
 
 

Tujuan Pembelajaran 
Dalam modul ini mahasiswa akan mempelajari parabola, elips, 

dan hiperbola pada kegiatan belajar 1 Setelah membaca dan 
mengikuti perkuliahan mahasiswa diharapkan dapat: 

1. Mengetahui definisi dan menentukan persamaan parabola 
2. Mengetahui definisi dan menentukan persamaan elips  
3. Mengetahui definisi dan menentukan persamaan hiperbola 

 
KEGIATAN BELAJAR 1 

 Parabola 
 Konik adalah irisan kerucut  
 Konik adalah perpotongan atau irisan antara bidang lengkung 

kerucut lingkaran tegak dengan bidang datar. 
 Konik adalah tempat kedudukan titik-titik yang perbandingan 

jaraknya ke titik tertentu dengan jaraknya ke garis tertentu 
mempunyai nilai tetap. 

 Titik tertentu = titik api (fokus) 
 Garis tertentu = garis arah (direktriks) 
 Nilai perbandingan tetap = eksentrisitas (e) 
 Konik terbagi empat, yaitu : 

o Berbentuk lingkaran  
o Berbentuk parabola 
o Berbentuk elips  
o Berbentuk hiperbola  

 

Sebuah parabola adalah himpunan titik-titik P yang berjarak 
sama dari garis l dan fokus F, yang memenuhi:  . Nilai 

eksentrisitas (e ) untuk sebuah parabola . 
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Gambar 5-1 

Perhatikan gambar diatas, kita ambil fokus F sebelah kanan 
titik asal, misalnya (p,0). Garis arah (direktriks) kita ambil disebelah 
kirinya dengan persamaan x=-p. Dengan demikian, puncak parabola 
ada di titik asal system koordinat. Karena  ,dengan 

menggunakan rumus jarak, kita peroleh: 

,setelah 

disederhankan diperoleh: 
 

  
 

Persamaan diatas disebut dengan persamaan baku sebuah 
parabola mendatar (artinya sumbunya mendatar) dan terbuka ke 
kanan. Perhatikan juga bahwa  dan  merupakan jarak dari 

focus ke puncaknya.  
Bentuk umum persamaan parabola yang berpuncak di titik 

pusat (0,0) yaitu: 

1. y2 = 4px parabola terbuka ke kanan  
2. y2 = -4px parabola terbuka ke kiri  
3. x2 = 4py parabola terbuka ke atas  
4. x2 = -4py parabola terbuka ke bawah  
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Contoh 1: 
Tentukanlah persamaan parabola dengan puncak dititik asal 
dan berfokus di (0,-4)! 

Penyelesaian: 
Dari keterangan diatas diketahui fokus (0,-4) maka parabola 
tersebut terbuka kebawah dan . Jadi persamaan parabola 

tersebut adalah  atau .  

 

 Elips 
Elips adalah tempat kedudukan titik-titik yang jumlah jaraknya 

terhadap dua titik tertentu mempunyai nilai yang tetap. Suatu irisan 
kerucut atau konik yang memenuhi persyaratan :  

adalah elips apabila memiliki nilai eksentrisitas  yaitu .  

 
Gambar 5-2 

Perhatikan gambar diatas, sumbu yang memuat kedua puncak 
(dan kedua fokus) dinamakan sumbu panjang dan sumbu yang 
melalui pusat dan tegak lurus pada sumbu panjang dinamakan 
sumbu pendek. Bilangan  dinamakan garis tengah panjang dan  

garis tengah pendek.  
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Bentuk umum persamaan elips yang berpusat di titik (0,0) 
yaitu: 

1.  (elips horizontal atau mendatar) 

2.  (elips vertikal atau tegak) 

Persamaan diatas disebut persamaan baku elips. Nilai 

eksentrisitas  , oleh karena  maka bilangan-bilangan 

dan  memenuhi hubungan Pythagoras . 

Berikut beberapa keterangan berkenaan dengan elips pada 
gambar 5-2: 

 

Rumus Elips horizontal Elips vertikal 
Titik puncak 
Titik sb pendek 
Fokus 
Panjang sb pjg 
Panjang sb pdk 
e 
Direktriks 

(-a,0) dan (a,0) 
(0,-b) dan (0,b) 
(-c,0) dan (c,0) 
2a 
2b 
c/a 
x=-a/e dan x=a/e 

(0,-a) dan (0,a) 
(-b,0) dan (b,0) 
(0,-c) dan (0,c) 
2a 
2b 
c/a 
y=-a/e dan y=a/e 

Contoh 2: 

Sebutkan nama konik dari persamaan berikut , 

kemudian tentukan titik fokus dan puncaknya! 

Penyelesaian: 
Dari keterangan elips diatas diketahui  dan , maka: 

 =   

Dengan demikian fokus elips berada pada  

sementara puncak elips berada pada . 

Berdasarkan keterangan di atas elips tersebut adalah elips 
mendatar atau elips horizontal. 

 

 Hiperbola  
Hiperbola adalah tempat kedudukan titik-titik yang selisih 

jaraknya terhadap dua titik tertentu mempunyai nilai yang tetap. 
Suatu irisan kerucut atau konik yang memenuhi persyaratan : 
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 adalah hiperbola apabila memiliki nilai eksentrisitas 

 yaitu .  

 
Gambar 5-3 

 
Perhatikan gambar 5-3 diatas, bentuk umum persamaan 

hiperbola yang berpusat di titik (0,0) yaitu: 

1.  (hiperbola horizontal atau mendatar) 

2.  (hiperbola vertikal atau tegak) 

Persamaan diatas disebut persamaan baku hiperbola. Nilai 

eksentrisitas  , oleh karena  maka bilangan-bilangan 

dan  memenuhi hubungan Pythagoras . Pada 

hiperbola juga terdapat garis-garis yang disebut dengan asimtot 
yaitu garis putus-putus yang terdapat pada gambar 5-3 diatas 

dengan ketentuan   
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Berikut beberapa keterangan berkenaan dengan elips pada 
gambar 5-2: 
 

Rumus Hiperbola horizontal Hiperbola vertikal 
Titik puncak 
Fokus 
Titik sb minor 
Panjang sb mayor 
Panjang sb minor 
e 
Direktriks 
Pers. Asimtot 

(-a,0) dan (a,0) 
(-c,0) dan (c,0) 
(0,-b) dan (0,b) 
2a 
2b 
c/a 
x=-a/e dan x=a/e 
y=(-b/a)x dan y=(b/a)x  

(0,-a) dan (0,a) 
(0,-c) dan (0,c) 
(-b,0) dan (b,0) 
2a 
2b 
c/a 
y=-a/e dan y=a/e 
y=(-a/b)x dan 
y=(a/b)x  

 
Contoh 3: 

Tentukan fokus hiperbola berikut ! 

Penyelesaian: 
Dari keterangan hiperbola diatas diketahui  dan , 

maka: 

 =   

Dengan demikian fokus hiperbola berada pada 

.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



P a r a b o l a ,  E l i p s ,  d a n  H i p e r b o l a  

57 Universitas Malikussaleh 

 

Rangkuman: 
1. Parabola adalah himpunan titik-titik P yang berjarak sama 

dari garis l dan fokus F, yang memenuhi:  . Nilai 

eksentrisitas (e ) untuk sebuah parabola . 

2. Bentuk umum persamaan parabola yang berpuncak di titik 
pusat (0,0) yaitu: 
y2 = 4px parabola terbuka ke kanan  

y2 = -4px parabola terbuka ke kiri  

x2 = 4py parabola terbuka ke atas  

x2 = -4py parabola terbuka ke bawah  

3. Elips adalah tempat kedudukan titik-titik yang jumlah 
jaraknya terhadap dua titik tertentu mempunyai nilai yang 
tetap. Suatu irisan kerucut atau konik yang memenuhi 
persyaratan :  adalah elips apabila memiliki 

nilai eksentrisitas  yaitu .  

4. Bentuk umum persamaan elips yang berpusat di titik (0,0) 
yaitu: 

 (elips horizontal atau mendatar) 

 (elips vertikal atau tegak) 

5. Hiperbola adalah tempat kedudukan titik-titik yang selisih 
jaraknya terhadap dua titik tertentu mempunyai nilai yang 
tetap. Suatu irisan kerucut atau konik yang memenuhi 
persyaratan :  adalah hiperbola apabila 

memiliki nilai eksentrisitas  yaitu .  

6. Bentuk umum persamaan hiperbola yang berpusat di titik 
(0,0) yaitu: 

 (hiperbola horizontal atau mendatar) 

 (hiperbola vertikal atau tegak) 
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LATIHAN 5 

1. Tentukanlah fokus dan garis arah dari parabola berikut 
kemudian gambarlah grafiknya! 
a.  

b.  

2. Tentukanlah persamaan parabola jika diberikan ketentuan 
sebagai berikut dan puncak parabola diambil di titik asal! 
a. Fokus adalah (3,0) 
b. Garis arah adalah x=2 

3. Sebutkan nama irisan kerucut atau konik berikut (elips tegak, 
hiperbola mendatar dan sebagainya)! 

a.  

b.  

c.  

4. Gambarlah grafik persamaan berikut, kemudian tentukan 
titik puncak, fokus dan asimtot (untuk hiperbola)! 

a.  

b.  

c.  

d. 4  

5. Tentukanlah persamaan elips berikut, anggaplah pusatnya 
berada pada titik asal! 
a. Elips dengan fokus (-3,0) dan puncak (6,0) 

b. Elips dengan fokus (6,0) dan keeksentrikan  

c. Elips dengan puncak (5,0) dan melalui (2,3) 
6. Tentukanlah persamaan elips berikut, anggaplah pusatnya 

berada pada titik asal! 
a. Hiperbola dengan puncak (0,-4) dan fokus (0,-5) 

b. Hiperbola dengan puncak (0,-3) dan keeksentrikan  

c. Hiperbola dengan fokus  dan garis arah  
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SOAL-SOAL ANEKA RAGAM 

1. Carilah keliling segitiga berikut dengan koordinat titik puncak 
 ! 

2. Dua titik sudut dari segitiga samasisi adalah 

 Tentukan koordinat titik sudut 

ketiganya! 
3. Carilah persamaan untuk tiap garis berikut. Kemudian tuliskan 

jawaban dalam bentuk  

a. Melalui (2,3) dengan kemiringan 4 
b. Melalui (2,-3) dan (2,5) 

4. Carilah kemiringan dan perpotongan-Y untuk tiap garis berikut! 
a.  

b.  

5. Tentukanlah persamaan garis yang melalui (0,4) dan tegak lurus 

pada garis  ! 

6. Berapakah nilai a agar garis  tegak lurus terhadap 

garis  
 ! 

7. Carilah persamaan lingkaran gambarkan grafiknya! 
a. Pusat (-1,3) dan melalui (2,-4) 
b. Pusat (3,0) dan melalui (7,3) 

8. Carilah persamaan lingkaran yang titik-titik ujung garis 
tengahnya (=diameter) (2,3) dan (-1,5)! 

9. Tentukan pusat dan jari-jari lingkaran berikut kemudian sketsa 
grafiknya! 
a.  

b.  

10. Carilah persamaan lingkaran berikut kemudian sketsa grafiknya, 
jika diketahui pusat (-4,-2) dan menyinggung sumbu-Y! 

11. Carilah pusat dan jari-jari tiap lingkaran berikut: 
a.  

b.  

 

12. Carilah persamaan garis singgung dari tiap lingkaran dan titik 
berikut! 
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13. Tentukan koordinat fokus dan garis arah parabola berikut, 
kemudian gambarlah parabola tersebut! 
a.  

b.  

14. Tentukanlah persamaan parabola berikut berdasarkan data 
yang diberikan. Puncak parabola berada di titik asal! 
a. Garis arah  

b. Fokus adalah  

15. Tentukanlah persamaan parabola yang puncaknya berada dititik 
asal sistem koordinat, jika parabola ini melalui titik (3,-1) dan 
yang sumbu simetrisnya adalah sumbu-X ! 

16. Tentukan persamaan parabola dengan puncak dititik asal, yang 
melalui (-2,4) dan terbuka kekiri. Gambarkan parabola tersebut! 

17. Buatlah sketsa grafik dari persamaan , kemudian 

tentukan fokus dan eksentrisitasnya! 
18. Tentukanlah persamaan elips berikut, anggaplah pusatnya 

berada pada titik asal!  
a. Elips dengan fokus (0,3) dan panjang diameter pendek 8 
b. Elips dengan puncak (5,0) dan melalui (2,3) 

19. Tentukanlah fokus, puncak dan asimtot untuk hiperbola berikut: 

a.  

b.  

20. Tentukan persamaan hiperbola berikut jika pusatnya berada 
dititik asal! 
a. Hiperbola dengan fokus (5,0) dan puncak (4,0) 
b. Hiperbola dengan asimtot dan puncak di (8,0) 

c. Hiperbola dengan asimtot  dan melalui titik (4,3) 
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